
Index to Using SuperFlow
SuperFlow is designed to assist you in designing technical diagrams and presentation materials rapidly. 
It is powerful, flexible and yet user friendly. With SuperFlow, you are able to create impressive Flow 
charts, organization charts and presentations with minimum effort. Just concentrate on your presentation 
idea, SuperFlow will do all the hard work for you.

Using SuperFlow Topics
Commands
Mouse



Help on Alignment Tool
Description
Use Alignment Tool to align objects bounded by Edit Block    Selected Objects can be aligned either 
vertically or horizontally.

Using Alignment Tool:
1. Alignment marker can be set optionally by selecting an object and then click on the Align - Marker 

menu.
2. Create an Edit Block large enough to encompass all the objects to be aligned.
3. Select either Vertical Align or Horizontal Align from the Alignment Tool sub-menu.
4. Objects will be aligned with the marked object. If marker is not set,    objects will be aligned using the 

average center point of the selected objects.
 
Comment
Edit Block must be defined to enable this command.



Help on Center
Description
Use Center to position the entire drawing to the center of the drawing canvas. 

Using Center:
1.    Simply select Center from Edit Menu and SuperFlow will do the rest!



Help on Clear
Description
Use this command to remove the selected objects from drawing canvas.    The deleted objects can not be 
recovered. 

Using Clear:
1. Select objects to be cleared using Edit Block
2. Choose Clear from Edit menu.

Comment:
Unlike Cut and Copy, this command does not transfer the deleted object(s) to the Clipboard.    



Help on Commands
1.0 Invoke Commands using Mouse
Position the cursor to the menu bar. Press and hold the mouse's left button. Move the cursor to the 
desired menu item and release the mouse's button.

1.1 Invoke Commands using Keyboard
Press Alt-key to highlight menu bar; Move the cursor using arrow keys to the desired and press ENTER to
invoke the command.

Available Commands
File
Edit
Options
Shape
View
Configuration
Help



Help on Connector Attributes
Description
Connection Attributes describe the characteristics of a connection.

Connection Mode
Automatic SuperFlow connects two objects by their relative position.
Custom User specifies how connection is made by specifying the connection edges.
Direct Connect two objects using a straight line.

Extend
Number of additional pixels used to extend the angular portion of the connection line. This is only valid if 
the connection mode is custom. By default, the extend value is set to 20. 

Round
Number of pixels used to round the angular portion of the connection line. By default, this value is set to 
0. 

Connector Style
Style Specify the appearance of the Connector. By default, it is set to none.
Point Specify at which the connection is made. The range is from 0 to 10.

By default, center point (5) is used.
Edge Specify from which edge the connection is made. By default, it is set to automatic.

This option is selectable only if connection mode is custom.

Line Style
Style Specify appearance of the connection line.
Thickness Specify the thickness of the connection line.
Color Specify the color of the connection line.

Text Button
Press this button to attach text to this connection. 

Add Button
Press this button to add additional connections. SuperFlow allows more than one connection per link.

Delete Button
Press this button to delete the current connection. 

OK Button
Press this button to confirm the changes.

Cancel Button
Press this button to discard the changes.

Comment
From Object and To Object is relative. The Object at higher position is referred as From object. 



Help on Connector List
Description
Connector List contains a collection of available connectors that can be used. 

Customize Connector List

Add
Connector List Configuration can be invoked from Configuration menu. The list box on the left contains 
available bitmap files. Pick one and click on the ADD button to include the bitmap file to Connector List.

Delete
Select Connector to be deleted from the list box on the right. Click on the DELETE button to remove it 
from Connector List.

Edit
Select Connector to be edited from the list box on the right. Click on the EDIT button. The following 
attributes can be changed as desired.

Category Use category to group connectors.    
Name Name of the Connector shown on Connector List.



Help on Configuration
Description
Configuration let you customize SuperFlow environment to your preference.

Configure Connection Default
Use this command to set up default Connection Attributes.

Configure Shape Default
Use this command to set up default Shape Attributes.

Configure Font Default
Use this command to set up default Font Attributes.

Configure ToolBox
Use this command to set up Toolbox's objects    to your preference.

Configure Object List
Use this command to set up default Object List    Bitmap Objects can also be import through this option.

Configure Connector List
Use this command to set up default Connector List    Bitmap connectors can also be import through this 
option.



Help on Connection
Description
Connection is used to link two objects together. Object can also be linked by itself.    Each connection is 
represented as vector line in drawing canvas. Connectors can be attached to both connection ends.

Define/Locate Connection
There are two ways to define or locate a connection. They are described as follows:

Define directly
Press and hold the mouse's right button while the cursor is at the From object; Move the cursor to the 
To object and then release the button. 

Define using Connect Object
Select connection from ToolBox. Press and hold the mouse's left button while the cursor is at the    
From object. Move the cursor to the To object and then release the mouse's button.

Add Connection
1. Define the connection as described above. 
2. Choose appropriated options from Connection Definition Panel.
3. Click on the OK button to add the connection.

Revise Connection
1. Locate the connection as described above. 
2. Revise the options in Connection Definition Panel.
3. Click on the OK button to confirm the revision.

Delete Connection
1. Locate the connection as described above. 
2. Click on the DELETE button from Connection Definition Panel to remove the connection.



Help on Copy
Description
Include the to be copied objects using Edit Block. Select Edit - Copy option to place the objects into 
Clipboard. Copied objects can be pasted back into the drawing canvas using the Paste command.

To copy objects from the drawing canvas:
1.    Define an edit block to include all the to be copied objects.
2.    Click on the Edit - Copy command.

Copied objects can be pasted back into the drawing canvas using the Paste command.

Comment
Edit Block must be defined to enable this command.



Clipboard
Storage area provided by windows to be shared with all applications.



Help on Cut
Description
Transfer objects bounded by the Edit Block Created by clicking and dragging over an area or objects 
resulting in a box to be edited from the drawing canvas to Clipboard. Objects can then be placed back 
onto drawing canvas using the Paste command.

To cut objects:
1.    Define an edit block to include the all the to be deleted objects.
2.    Click on the Edit - Cut command.

Deleted objects can be pasted back into the drawing canvas using the Paste command.

Comment
Edit Block must be defined to enable this command.



Help on DOS
Description
Use this command to invoke a MS DOS command session without exiting SuperFlow. To return to 
Windows, type EXIT and press ENTER.



Help on Edit
Description
Edit menu includes a set of tools to manipulate the current drawing. 

Cut
Use this option to delete selected object or objects bounded by the Edit Block. 
Deleted object(s) can be pasted back into drawing canvas using Paste command.
Object must be selected or an Edit Block must be defined to enable this command.

Copy
Use this option to copy selected object or objects bounded by the Edit Block to clipboard. 
Copied object(s) can be pasted back into drawing canvas using Paste command.
Object must be selected or an Edit Block must be defined to enable this command.

Paste
Place objects from clipboard to the area bounded by Edit Block in drawing canvas. 
An Edit Block must be defined to enable this command.

Clear
Use this command to delete selected object or objects bounded by the Edit Block. Notice that the deleted 
object(s) will not be saved in clipboard. 
Object must be selected or an Edit Block must be defined to enable this command.

Refresh
Due to unpredictable circumstances, drawing may not be redrawn correctly. Use Refresh to    repaint the 
entire drawing unconditionally.

Center
Use this command to reposition current drawing to the center of the drawing canvas.

Align
Use this command to align objects bounded    by the Edit Block. Objects can be aligned either vertically or
horizontally.
 
You can also mark an object as the alignment base by clicking on the marker object and select    the Align-
Marker option. 

An Edit Block must be defined to enable this command.

Space
Use this option to define an Edit Block that includes all the objects for spacing operation. The included 
objects will then be spaced evenly within the boundary of the Edit Block. You can choose to space the 
objects either vertically or horizontally.

Sizing
Use this option to define an Edit Block that includes all the objects for sizing operation. From the Size 
Dialog, a combination of sizing options can be specified for horizontal and vertical dimension. For 
example, to keep the size of the objects unchanged, check on "No Change" button; To size the objects to 
the smallest object's dimension, check on "Shrink to Smallest" button; To size the objects to the largest 
object's dimension, check on "Grow to Largest" button;    Change the dimension of the object just large 
enough to hold the specified text, check on "Fit Text" button.

Refer
Select a group of objects by defining an Edit Block. Click on this option to activate the Refer List Dialog. 
Select a to be referred object by doubling click one of entries. You will be prompted for " Refer object 



Shape Only?". If you answer Yes, all attributes of the included objects will remain unchanged; Only the 
shape of the included objects will be copied; Otherwise, the referred object's attributes will be copied to 
the included objects.

You can remove an existing referred object from Refer list by double clicking the object's entry and then 
push on the Delete button.

Template
Use this command to add, delete or paste from a drawing template. Drawing template is used to define a 
set of most frequently used drawing objects for reusable purposes. Once the drawing objects are defined 
and included in template list, it can be pasted into drawing canvas whenever you need it.
 
An Edit Block must be defined to enable this command.

Add Template
First, define an Edit Block to include all the drawing objects; Then assign a name for the template. Finally,
click on the ADD button from Template Panel to add a new template.

Delete Template
Select the template to be deleted from Template Panel, click on the DELETE button to remove the 
template.

Place Template
Select the template to be placed    from Template Panel. Click on the OK button to place the template 
objects into Edit Block.



Help on Edit Block
Description
Edit Block is a rectangular area defined by user for group operations such as Cut, Copy, Paste, Align, 
Size, Template, Block Move, Font and Refer.

Define
Press and hold the mouse's left button to initialize the Edit Block upper leftmost position. Move the cursor 
using the mouse to the desired lower rightmost position and release the button. All objects intersect with 
the rectangle are selected for further operation. 

Cancel
Click the mouse without selecting any operation will cancel the Edit Block.



Help on Exit
Description
Use this command to terminate SuperFlow and return to Windows.



Help on Export
Description
Use this command to convert current drawing into window bitmap format. The converted file can be used 
by other paint program that support bitmap file format. For example, you can use Paintbrush to redefine 
the drawing or incorporate the bitmap file into Microsoft Word.



Help on File Menu
Description
The File Menu includes commands that will allow you to manipulate current drawings.    Examples are 
creating a new file, opening a file from disk,    saving your file to disk, printing, and overall layout of your 
document.

Available Commands
New
Open
Save
Save As
Export
Print
Printer Setup
Page Setup
Dos
Exit



Help on Font Attributes
Description
Font Attributes describe the appearance of the associated text.

Type Face
Use this option to specify the type face of the associated text.

Font Size
Use this option to specify the font size of the associated text.

Style
Use this option to define a combination of font styles for the associated text. Styles that can be specified 
are Bold, Underline and Italic.

Alignment
Use this option to describe how the associated text is to be aligned. Text can be left aligned, right aligned 
or center aligned. 

Position
Use this option to describe how the associated text is to be positioned. Text can be position at the top, at 
the bottom or at the center.

Show
Use this option to show or to hide the associated text. It is somewhat useful if you intend to use the 
associated text as comments.

Line
Use this option to specify how many lines the associated text will be broken into. This is valid only if the 
Auto Line Break option is on.

Auto Line Break
Use this option to turn on and off the automatic line breaking option.

Delimiter
This option is valid only if Auto Line Break option is off. The delimiter specified is treated as end of line 
character.



Help on Help

Description
Help commands provide on-line references for SuperFlow.

Index 
Display master Index for SuperFlow's on-line help topics

Help On Help
Get Instructions for how to use the Microsoft Windows' help system.

About
Display product information.



Help on Link
Description
Linkage allows you to link up related drawing to a drawing object.
 
Define Link 
Click on the DEF.LINK button from object Definition Panel; A list of files that can be linked to will be 
displayed. Select one and press the OK button.

Delete Link
Click on the DEF.LINK button from Object Definition Panel; Press the DELETE button to remove the 
Linkage.

Link to linked file
Double click the mouse's right button or press the LINK button from Object Definition Panel to invoke the 
linked drawing.



Help on Mouse
General
Left button is used to highlight an item. Double click on an item will select the item immediately.

Left button 
Select Object or Shape
Move Object, Shape or Edit Block

Right button
Connect two objects
Jump to linked file
Change View Mode



Help on New
Description
Use this command when you want to create a new drawing.    You will be prompted to provide a new Page
Specification for the new drawing. 



Help on Object Attributes
Description
Object Attributes are used to set up an object. They are described in below:

Name
Name is the identifier of an object. It is an optional entry unless you need to add the object to Refer List. 

Text
Text defined will be shown on drawing canvas unless the show attribute is checked off.

Font
Define Font Attributes for Text defined.

Refer
This is used to add an object to Refer List or to copy object's attributes from Refer List to the current 
object. 

Define Link
This is to define a link between an object and a drawing. If the link is defined, double click the linked 
object will invoke the associated diagram.



Help on Object
Description
There are two types of drawing items in SuperFlow. Drawing objects are images stored in bitmap format 
and shapes are pre-defined vector line drawings. Both objects and shapes can be placed into the drawing
canvas. 
    
SuperFlow comes with a set of standard objects. Since objects are stored in bitmap format, you can add 
in new objects or modify an existing one using any paint program that supports bitmap format. In addition,
drawing objects can    be connected together using connection objects.

Place Object 
There are two ways you can place an object into the drawing canvas. You can select the object to be 
placed from Object List Panel or you can place the object directly from ToolBox.    Both ways will place the
selected object into the drawing canvas at current cursor position.

Revise Object
Move the cursor to the area bounded by the object and double click the mouse's left button to bring up the
definition panel for editing. 

Move Object
Move the cursor to the area bounded by the object; Press and hold the mouse's left button while moving 
the cursor. A black box will be drawn to reflect the new position of the object.    Release the mouse's left 
button to place the object at the current cursor position. 

Delete Object
Double click the mouse's left button within the area bounded by the object to be deleted. Click on the 
DELETE button from Object Definition Panel to remove it from the drawing canvas.

Select Object
Single Click the mouse's left button within the area bounded by the object to select the object. Actions like
Cut, Copy, Size and set alignment marker can then be operated on the highlighted object.

Size Object
You can size an object by dragging one of the eight gray rectangles surrounding the objects. To maintain 
the vertical and horizontal ratio of the object during sizing, hold the shift key while dragging.



Help on Object List
Description
Object List contains a list of available objects that can be placed into drawing canvas. You can invoke 
object windows either using the menu bar or double clicking the mouse's left button on the non-occupied 
area of the drawing canvas. Object selected is placed into the drawing canvas at current cursor position.

Customize Object List
Add
Object List Configuration can be invoked from Configuration menu. The list box on the left contains 
available bitmap files. Pick one and click on the ADD button will import the bitmap file to Objects List 

Delete
Select the object to be deleted from the list box on the right. Click on the DELETE button to remove the 
object from Object List.

Edit
Select the object to be edited from the list box on the right. Click on the EDIT button. The following 
attributes can be changed as desired.

Category Use category to group the objects
Name Name of the object shown on Object List.

Size in Pixels
This is the width and height of the bitmap graphic defined in pixels. You can change the original settings 
to scale it up or down.

Reset
Reset Object List to manufacturer's Default.

Import Foreign Bitmap File:
Windows' Paintbrush program or other bitmap compatible paint programs can be used to design your own
drawing object. Belows are some guidelines you should follow when designing your own drawing object:
1 Define the bitmap's dimension as 72 X 72 pixels. (About 1 logical inch)
2. Set bitmap's color to 2 or 16.
3. Save your drawing in bitmap file format (.BMP extension).
4. Bitmap file must be saved in SuperFlow's executable directory. 
5. When designing your own object, always align them in center horizontally and 

vertically. If object does not occupy the whole 72 X 72 area, make sure the left and the
right margins are identical. Same rule also applies to set up the top and bottom margin.



Help on Open
Description
Use this command to retrieve previously saved drawings from hard disk or floppy disk.    To retrieve a 
drawing, first make sure that the correct drive is selected.    Next, select the file that you want to open from
the the File List box.    Click on the OK button to retrieve the highlighted file.

Comment
If you do not see your file in the File List box, check that the correct drive and path are selected and be 
sure that you have scrolled through the list using either the scroll bars on the right of the box or by using 
the keyboard's arrow keys.    



Help on Options
Description
Options Menu includes a set of commands to    customize SuperFlow's working environment. 

Use Default Object definition
When this option is checked on, double clicking    the left mouse's button will place the default object into 
the drawing canvas directly. 
 
Use Default Connection Definition
Use this command to disable the system from prompting you for new connection attributes. Instead, 
default connection attributes will be applied. 

Use Default Shape Definition
Use this command to disable prompting for new shape attributes. Instead, default shape attributes will be 
applied.    

Enable Transparent Text
Use this command to melt associated text with the attached    object.    If this option is off, the background 
of the associated text will cover part of the object.

Lock Object Position
Use this command to inhibit objects' movement. Although the objects are locked, you can still modify the 
objects' definitions. 

Show Connection
Turn on this option if you prefer SuperFlow showing new connection position while objects are moved. Do
not turn on this option if performance is your concern.

Show Ruler Guide
Turn on this option if you prefer SuperFlow showing ruler guides while object is moved. This option is 
allowed only if the rulers are shown. Do not turn on this option if performance is your concern.



Help on Page Setup
Text
Use text option to define a title for your drawing.

Orientation
Define page mode by selecting either portrait or landscape orientation.      

Page Size
Define the size of the drawing canvas. Pick the desired entry from the list.

Password
Passwords can be used to protect your files from unauthorized access.    Leave this blank if you do not 
wish to have a password protecting the current file. 

Font
This option is used to define the Font Attributes of the page title.



Help on Paste
Description
Place objects from Clipboard to the area bounded by Edit Block into the drawing canvas. Edit Block 
defined must be large enough to encompass the to be pasted objects.

To transfer an object from Clipboard into the drawing canvas:
1.    Define an Edit Block on the drawing canvas where you want the object(s) to be placed. (Note: Edit 
Block must be large enough to hold all the objects from the Clipboard.)
2.    Choose Paste from the Edit menu.

Comment
Edit Block must be defined to enable this command.    Objects remain in the Clipboard until the next Cut 
or Copy operation.    Thus, objects may be placed into the drawing canvas more than once.



Help on Print
Description
This command is used to print the current drawing.

By default, SuperFlow will print only one copy of the drawing.    To have more than one copy, specify the 
number of copies you wish to print.

If necessary, click on the PRINTER SETUP button of Print Panel to configure a printer.

To abort printing while printing is in process, click on the CANCEL button of the Print Status Panel.



Help on Printer Setup
Description
This command is used to select another Windows printer as well as to configure the current printer.    
Objects such as print quality control, page orientation, and resolution can be maintained.    Note that 
printer orientation and page orientations must be the same as the drawing.



Help on Refresh
Description
Using Refresh allows you to reconstruct the drawing on screen.



Help on Refer
Description
Refer is a powerful tool to copy attributes from one object to another. From reusability point of view, 
frequently used objects should be added to Refer List. You can refer an object by adopting all attributes 
from the referred object; Or you can adopt just the appearance of the referred object. 

Add Object to Refer List
1. Invoke Object Definition Panel.
2. Make up a descriptive name for the Object.
3. Click on the REFER button.
4. Click on the OK button from the Refer Panel to add the current object to Refer List.

Delete Object from Refer List
Select the entry to be deleted from Refer List. Click on the DELETE button to remove the selected object 
from Refer List.

Refer
Select an entry from Refer List and click on the OK button. 



Help on Ruler
Description
Turn this option on or off to show or to hide the horizontal and vertical rulers respectively.

Note: This option has to be turned on to enable Show Ruler Guide command.



Help on Save
Description
Use this command to save current drawing using the name previously given to your drawing.    If a name 
has not yet been defined for current drawing, SuperFlow will prompt you for the file name. We 
recommend that you save your file as frequently as possible.



Help on Save As
Description
Use the Save As command to save the current drawing with a new name. 

Note: If you do not select a new path for your drawing, your file will be saved in the default path.



Help on Shape
Description
Shapes are pre-defined sizable vector line objects. Usually, shapes are used to highlight a particular 
section of a drawing. For example, you may want to use a dot lined rectangle to group a set of objects.

To define a shape object, define a rectangular area and pick a shape from the menu. After the shape 
attributes are specified from the definition panel, the shape selected will be drawn within the defined 
rectangular area. A rectangular area must be defined to enable    the Shape commands. 

The following are built in shapes that can be selected.    

Rectangle
Ellipse
Diamond
Hexagon
Octagon
Triangle

Up
Down
Right
Left

Place Shape 
Click and drag using the mouse's left button to define an Edit Block; Select a shape from Shapes menu to
placed it into the Edit Block.

Revise Shape
Double click the shape to be revised to invoke the Definition Panel.

Move Shape
Move the cursor to the area bounded by the shape. Click and drag the shape to its new position.    A dot 
lined rectangle is drawn to reflect the new position of the shape. Release the mouse's left button to 
reposition the shape at the current cursor position.

Delete Shape
Double click on the shape to be deleted. Click on the DELETE button from Shape Definition Panel to 
remove the shape from drawing canvas.



Help on Shape Attributes
Description
Shape Attributes describe the appearance of a shape.

Frame Style
Define a shape's border style. 

Single Line
Shape's border is a single line.

Double Lines
Shape's border is a double line.

Shadow
Define a shadow border. Apply for rectangle only.

Square Corners
Define a right-angled rectangle. Apply for rectangle only.

Round Corners
Define a round-corners' rectangle. Apply for rectangle only.

Line Style
Define the line style of a shape.

Thickness
Border line thickness can be thin, medium, or thick.

Type
Border can be either solid or a dotted line.

Comments

1. Inner line style is available only for Rectangle with double line attribute defined.
2. Line thickness, medium and thick, applies for solid line only.



Help on Size
Description
Use this option to define an Edit Block that includes all the objects for sizing operation. From the Size 
Dialog, a combination of sizing options can be specified for horizontal and vertical dimension. 

Using Size:
1. Create an Edit Block large enough to encompass the objects to be sized.
2. Select Size from the Edit menu.
3. Click on the desired sizing options for horizontal or vertical dimension:

No Change
Size of the object is not changed.

Shrink to Smallest
Change the size of the selected objects to the smallest object's size.

Grow to Largest
Change the size of the selected objects to the largest object's size.

Fit Text
Change the size of the selected objects to the attached text's size.

Comment
An Edit Block must be defined to enable this command.



Help on Space
Description
Use this option to define an Edit Block that includes all the objects for spacing operation. The included 
objects will then be spaced evenly within the boundary of the Edit Block. You can choose to space the 
objects either vertically or horizontally.

Using Space:
1. Create an Edit Block large enough to encompass the objects to be spaced.
2. Select either vertical or horizontal spacing from the Space sub-menu.

Comment
An Edit Block must be defined to enable this command.



Help on Template
Use this command to add, delete or paste from a drawing template. Drawing template is used to define a 
set of most frequently used drawing objects for reusable purposes. Once the drawing objects are defined 
and included in template list, it can be pasted into drawing canvas whenever you need it.

Add Template
First, define an Edit Block to include all the drawing objects; Then assign a name for the template. Finally,
click on the ADD button from Template Panel to add a new template.

Delete Template
Select the template to be deleted from Template Panel, click on the DELETE button to remove the 
template.

Place Template
Select the template to be placed    from Template Panel. Click on the OK button to place the template 
objects into Edit Block.

Comment
An Edit Block must be defined to enable this command.



Help on ToolBox
Description
ToolBox contains a collection of most frequently used objects. 

Instead of double clicking the mouse's left button to invoke object window, you can select the desired 
objects from ToolBox. 

To select an object from ToolBox, click on the mouse's left button to highlight one of the ToolBox entries. 
Click on the mouse's left button one more time in the drawing canvas will place the selected object at 
current cursor position.

Customize ToolBox
1. Select an Object from Object List.
2. Move the cursor to where you want the object to show in ToolBox.
3. Click on the mouse's left button to replace the original object by the selected object.



Help on View
Description
Use this command to control the appearance of the your drawing canvas.

View
There are two View Modes: 100% Mode and 50% Mode.

100% Mode Display objects in actual logical inches . 
50% Mode Display objects in 50% of actual logical inches. 

Comments

View can be changed either by accessing the VIEW menu or by double clicking the mouse's right button 
on a non-occupied area of drawing canvas.






